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Instruction Manual

Content of this Instruction Manual
PSE stands for Picture Style Editor.
In this manual, the windows used in the 
examples are from Windows 10.
 indicates the selection procedure of the menu.
(Example: [File] menu  [Exit].)
Square brackets are used to indicate items such 
as menu names, button names and window 
names that appear on the computer screen.
Text inside < > indicates a key on the keyboard.
p.** indicates a reference page.
Click to move to the relevant page.

 : Marks information that should be read 
before use.

 : Marks additional information you may find 
helpful.

© CANON INC. 2021     CEL-SY3XA210

Switching Between Pages
Click on arrows on the bottom right of the screen.

 : next page
 : previous page
 : return to a page you had previously 

displayed
Click on the headings on the right side of the 
screen to switch to the contents page of that 
heading. Also, click the item you want to read 
about on the table of contents to move to the 
relevant page.

ENGLISH
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Introduction
Picture Style Editor (hereinafter, “PSE”) is software that allows you to edit 
Picture Style to your unique image characteristics and save the edited 
results as original Picture Style files.

 What is a Picture Style file?
A Picture Style file (extension “.PF2” or “.PF3”) is an extended 
function of a Picture Style. It differs from the eight preset Picture 
Styles (Auto, Standard, Portrait, Landscape, Fine Detail, Neutral, 
Faithful and Monochrome) and provides image characteristics that 
are effective in a very limited number of scenes.
You can further expand your photographic expression by using a 
Picture Style file effective for a specific scene.

 Main Features of PSE
With PSE, you can use the functions below to edit Picture Style to 
your unique image characteristics and save the edited results as 
original Picture Style files (extension “.PF2” or “.PF3”).
 Select a Picture Style to be used as a basis for your images
 Set the [Sharpness], [Contrast], [Color saturation] and [Color tone]
 Make adjustments to a specific color
 Adjust the brightness and contrast (gamma characteristic)
In addition, you can register your saved original Picture Style files on 
a camera with the Picture Style function and then apply those styles 
to shot images. You can also use Digital Photo Professional  
(hereinafter, “DPP”) to apply the styles to RAW images.

 Color Management
Use PSE in a computer environment with color management. 
Also, set the profile of the monitor you are using and the color space 
of the sample image to be used to perform the adjustments, etc. in 
the preferences window (p.21).

System Requirements

• Only supported on 64-bit OSs. Cannot be installed or used on 32-bit 
version PCs.

* With Microsoft .NET Framework installed

OS (operating 
system) Windows 10*, Windows 8.1*

Model PC with one of the above OS preinstalled
(Upgraded machines not supported)

CPU

Images shot with EOS-1D X Mark III, EOS R5, 
EOS R6:
Intel Core i series (recommended Intel Core i7 or 
later)
Images shot with other cameras:
Core 2 Duo 2.0 GHz or faster (recommended Core i 
series or later)

RAM 
(memory)

Images shot with EOS-1D X Mark III, EOS R5, 
EOS R6:
4.0 GB or more of RAM (8.0 GB or more 
recommended)
Images shot with other cameras:
2.0 GB or more of RAM (4.0 GB or more 
recommended)
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Sample Images for Adjustment
PSE enables you to use RAW images shot with EOS cameras* 
(excluding the EOS DCS1 and EOS DCS3), PowerShot G7 X Mark II, 
PowerShot G9 X Mark II, PowerShot G1 X Mark III, PowerShot G5 X 
Mark II, and PowerShot G7 X Mark III as sample images for adjustment. 
You can then save the completed adjustments as original Picture Style 
files.

* Compatible with RAW images shot with EOS D2000 that have been 
converted to RAW images using the CR2 Converter and have the 
“.CR2” extension.
For information on CR2 Converter, refer to Canon website.
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Preparing Sample Images
PSE uses a sample image to perform the various adjustments and save 
the adjusted results as an original Picture Style file. For this reason, a 
sample image (p.3) to be used for this purpose needs to be prepared in 
advance and saved on your computer.
The settings performed in PSE are saved as a Picture Style file (p.19) 
which is separate from the sample image, and the sample image used 
to perform the adjustments is not affected at all.

Starting up PSE
Double-click the [Picture Style Editor] icon on the 
desktop.
The main window (Description on the right) appears when PSE 

starts up.

Opening a Sample Image
Open a sample image and perform various adjustments with that image 
as a basis.
Noise reduction to the sample images may be applied by PSE included 
in EOS Solution Disk Ver.26 or later.

Drag and drop a sample image to the main window.

The sample image is displayed in the main window with the 
camera settings at the time of shooting.

The [Tool palette] appears.

Drag and drop

 If you open an image as a sample image with PSE, the shot 
settings on the camera will appear in the image. However, the 
Auto Lighting Optimizer settings will not appear.

 If you adjust a RAW image in DPP and then open it as a sample 
image with PSE, the adjustments made in DPP will not appear in 
the image.
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Basic Windows

You can select the display magnification and the display method, etc. of the sample image.

Main Window

Full view

Normal screen

Before and after 
adjustment 
comparison display
(Top/bottom split) 
(p.7)

Image rotation
(90 degree 
increments to the 
left or right)

Before and after 
adjustment 
comparison display
(Left/right split) (p.7)

Display magnification 
(5 ratios: 12.5%, 25%, 
50%, 100% and 200%)

100% (actual pixel size) 
view

Color values of the cursor position (Before adjustment/after adjustment/
difference between before and after adjustment) (8-bit conversion)

Work color space display (p.21)

Cursor coordinates 
position

Color display mode (p.18)
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Enlarging a Specific Area
You can enlarge a specific area in the main window to 100%.

In the main window, double-click the area you want 
to enlarge.

The area you double-clicked is enlarged to 100% (actual pixel 
size). If you wait for a while, it changes to a clearer display.

 To change the display position, drag on the image or drag the 
enlargement display position (p.8) in the [Navigator] window.

 Double-click again to revert to the full view.

Double-click

Adjusting While Comparing with the Original Image
You can display before and after versions of an adjusted image in the 
same window and perform adjustments while checking the adjustment 
results.

Select [ ] or [ ].

The images are displayed split top and bottom or left and right.

[ ] (Top/bottom split) display [ ] (Left/right split) display

 The image before adjustment 
is displayed at the top, and 
that after adjustment at the 
bottom.

 The image before adjustment 
is displayed on the left, and 
that after adjustment on the 
right.
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The display position of an image when it is enlarged in the main window 
and the image histogram can be displayed in the navigator window. You 
can also set warning indicators to prevent excessive settings being 
made.

Display the [Navigator] window.
 Select the [View] menu  [Navigator].

Navigator Window

Enlargement display position 
(p.7)
Move the display position by 
dragging

Histogram

Warning range

Warning indicator setting

Switches the histogram display

[Y] in the histogram display indicates luminance.

Setting the Warning Indicators
You can set warning indicators for luminance values (Y) and color 
values (RGB) which are useful for preventing excessive settings being 
made. Luminance and color value domains which are outside the set 
range blink as warning indicators on images in the main window.

1 Checkmark [Show warning on images] and select [Y] 
or [RGB].

2 Enter the upper and lower limit values of the warning 
range.
The domain where values are outside the upper and lower limit of 

the range blinks on the image in the main window.
 To stop the warning indicators, remove the check mark from the 

[Show warning on images] checkbox.
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You can adjust the image characteristics of the Picture Style file by using the various functions of the [Tool palette].
The adjustments made with the [Tool palette] are immediately applied to the image in the main window, enabling you to check the results as you work.
We recommend that you make adjustments in the following order.
(1) Adjust with the [Basic] tab sheet (p.11)
(2) Adjust with the [Six Color-Axes] tab sheet (p.13)
(3) Adjust with the [Specific Colors] tab sheet (p.14)

[Basic] Tab Sheet
Make basic adjustments to image 
characteristics.

[Six Color-Axes] Tab Sheet
Make color adjustments to image 
characteristics.

[Specific Colors] Tab Sheet
Make fine adjustments to a specific 
color gamut.

Tool Palette

You can select the [View] menu  [Tool palette] to switch the [Tool 
palette] show/hide.
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Pre-adjusting the Images
Sample images used in the adjustment process (p.3) which do not have 
proper exposure or white balance can be adjusted using the 
[Preliminary adjustment] window to correct their brightness and white 
balance.
However, please remember that adjustments made with the [Preliminary 
adjustment] window are merely pre-adjustments for performing 
adjustments with the [Tool palette] (p.9). For this reason, adjustments 
made with the [Preliminary adjustment] window are not saved in the 
Picture Style file which you create.
If the sample image used for adjustments has proper exposure and 
white balance, it is not necessary to make adjustments with the 
[Preliminary adjustment] window.

1 Select the [Tools] menu  [Preliminary adjustment].
The [Preliminary adjustment] window appears.
 When the [Preliminary adjustment] window appears, the display 

switches to normal display, even if the main window display is 
showing a comparison of images before and after adjustment 
(p.7).

2 Adjust to correct the brightness of the image.

The adjustments are applied to the image.

Correcting the Brightness

Drag to the left or right 
to adjust

Adjust to correct the white balance.

The adjustments are applied to the image.

Correcting the White Balance

Select the white balance

The color temperature slider
Select [Color temperature] from the white balance 
list box, then drag the slider left or right

Click white balance
Click the [ ] button 
and then click on a point 
that is to be the standard 
for white
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Making Basic Adjustments to Image Characteristics
Use the [Basic] tab sheet in the [Tool palette] to make basic adjustments 
to image characteristics.

Select the [Basic] tab in the [Tool palette].

The [Basic] tab sheet appears.

Adjust the Gamma 
Characteristic for RGB (p.12)

Adjust Sharpness, Contrast, 
Color saturation, and Color 
tone (p.12)

Select a Picture Style to be 
used as a basis (this page)

Save a Picture Style file 
(p.19)

Load a Picture Style file (this page)

Select the Picture Style used as the basis of the adjustments from the 
preset Picture Styles except Auto or Monochrome.
You can also register and use a Picture Style file effective for the scene 
that you have downloaded from Canon website.

Using a Downloaded Picture Style File 
Effective for the Scene

Select a Picture Style.

The selected Picture Style is applied to the image.

1 Click the [ ] button.
The [Open Picture Style file] window appears.

2 Select a Picture Style file to be registered and click 
the [Open] button.
The selected Picture Style file is applied to the image.

Selecting a Picture Style to Be Used as a Basis

 Original Picture Style files created with PSE (p.19) can also be 
registered and used by following the procedure above.

 Picture Style files compatible with PSE are files with the “.PF2” or 
“.PF3” extensions.

 You cannot select [Fine Detail] in [Base Picture Style] for the 
images shot with a camera which does not have [Fine Detail] as a 
preset Picture Style.
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The settings are applied to the image.

Setting Sharpness, Contrast, Color Saturation and Color Tone

[Fineness] or [Threshold] in [Sharpness] cannot be set for the 
images shot with a camera which does not have [Fine Detail] as a 
preset Picture Style.

You can use the tone curve to adjust brightness and contrast under 
RGB.
Use the tone curve in this tab sheet before adjusting with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet.

Adjust the brightness and contrast.

The brightness and contrast of the image change.
 The horizontal axis shows the input level and the vertical axis 

shows the output level.
 The maximum number of [ ] is 10.
 To delete a [ ], select the [ ] and then either press the <Del> 

key on the keyboard or double-click on the [ ].

Adjusting the Gamma Characteristic for RGB

The value of the 
selected point (you can 
also enter numerical 
values)

Click to add a [ ] 
(adjustment point) and 
adjust by dragging

Note that if you adjust the tone curve in the [Basic] tab after making 
adjustments with the [Six Color-Axes] tab sheet or [Specific Colors] 
tab sheet, the color characteristic will be further adjusted and 
intended image characteristics may not be achieved. To further 
adjust brightness and contrast after adjusting with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet, use the tone curve for 
adjusting luminosity in the [Specific Colors] tab sheet.
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Adjusting Color
You can adjust the color region you selected using hue, saturation, and 
luminosity.

1 Select the [Six Color-Axes] tab in the [Tool palette].

The [Six Color-Axes] tab sheet appears.

Note that if you adjust a color with the [Basic] tab sheet after making 
adjustments with the [Six Color-Axes] tab sheet, the color 
characteristic will be further adjusted and intended image 
characteristics may not be achieved. We recommend that you make 
adjustments in the following order.
(1) Adjust using the [Basic] tab sheet, (2) adjust using the [Six 
Color-Axes] tab sheet, (3) adjust using the [Specific Colors] tab 
sheet.

Save a Picture Style file (p.19)

Load a Picture Style file (p.11)

Hue adjustment sliders (p.14)

Hue region select buttons
(this page)

Adjustment color wheel 
(this page)

2 Select the color region you want to adjust.

 Select the color region you want to adjust from the adjustment 
color wheel.
You can also select the color region by clicking a hue region 
select button.

3 Adjust the upper and lower hue limits for the 
selected region.

 You can adjust the upper and lower hue limits for the selected 
region by dragging the boundary lines for each hue in the 
direction of the circumference.
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4 Adjust color.

 Drag the sliders to adjust color. You can also directly enter values 
to adjust.
H: Adjust hue.
S: Adjust saturation.
L: Adjust luminosity.

Making Minute Adjustments to Color
You can make minute adjustments to a color you have specified, using 
the hue, saturation and luminosity functions in order to get the color you 
want. You can also set a range for the effect on surrounding colors 
which occurs when you adjust the colors you have specified.

1 Select the [Specific Colors] tab in the [Tool palette].

The [Specific Colors] tab sheet appears.

Note that if you adjust a color with the [Six Color-Axes] tab sheet or 
[Basic] tab sheet after making adjustments with the [Specific Colors] 
tab sheet, the color characteristic will be further adjusted and 
intended image characteristics may not be achieved. We 
recommend that you make adjustments in the following order.
(1) Adjust using the [Basic] tab sheet, (2) adjust using the [Six Color-
Axes] tab sheet, (3) adjust using the [Specific Colors] tab sheet.

Minute adjustments to 
a specified color (p.15)

Save a Picture Style file (p.19)

Load a Picture Style file (p.11)

Adjust the gamma characteristic for luminosity (p.18)

Adjustment color list (p.17)

Color display mode (p.18)
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2 Specify the color you want to adjust.
 Click the [ ] button and then click the color you want to 

adjust on the image.

The selected color is displayed as an adjustment point [ ] on 
the color wheel.

Click

Click

3 Determine the range of effect for the color you want 
to adjust.

 The range of effect for hue, saturation, and luminosity can be set 
within the limits below.

Color of the adjustment point selected in step 2

Range of upper and lower limit of saturation
Drag to move towards the center or towards 
the outer perimeter

Range of upper and lower limit of hue 
Drag to move along the circumference

Range of 
upper and 
lower limit of 
luminosity
Drag to 
move up or 
down

Luminosity level of the adjustment 
point selected in step 2

Within the frame is the range of effect

Setting Range

Hue 30 - 180 degrees

Saturation 30 - 100

Luminosity 30 - 100
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4 Adjust the color.

The color is adjusted to the range specified in step 3 and the 
color of the image changes.

 When dragging the slider, the point before adjustment [ ] and 
the point after adjustment [ ] will be displayed on the color 
wheel. 

Drag to the left or right to adjust

5 Check the range of application.
 If you checkmark [Show affected area on images], the range of 

application of the adjusted color blinks on the image.

6 Repeat steps 2 to 5 to adjust multiple colors.
 You can select and adjust colors for up to 100 spots.

 When using EOS Utility’s Remote Live View function with PSE to 
edit Picture Styles, the [Show affected area on images] checkbox 
is not displayed, and you cannot check the range of application of 
adjusted colors.

 You can also specify the color to be adjusted in the method 
different from the one explained in step 2 (p.17).
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In addition to specifying the adjustment point by clicking the color on the 
image (p.15), you can also specify the color directly on the color wheel 
or by entering the color value.

Specifying the Color on the Color Wheel 

Specifying the Color by Entering the Color 
Value 

1 Click the [ ] button (p.15).

2 Click the color you want to adjust on the color wheel.
The selected color is displayed as an adjustment point [ ] on 

the color wheel.

1 Select the [Edit] menu  [Specify the numerical 
values for color adjustment].
The [Specify the numerical values for color adjustment] window 

appears.

2 Enter the color value.
The entered color value is displayed as an adjustment point [ ] 

on the color wheel.

Specifying the Color Directly
In addition to displaying colors before and after adjustment, the 
adjustment color list (p.9) shows overlapped range of effect of adjusted 
colors, and has a checkbox for specifying whether applying adjusted 
colors or not.

Overlapped Range of Effect of Adjusted 
Colors
When you select an adjusted color from the list and [ ] appears, the 
range of effect of the adjusted color (p.15) is overlapping with the range 
of effect of other adjusted colors.
Moreover, the overlapped areas will be displayed in gray on the color 
wheel and an adjustment combining the original adjustments is applied.
To avoid an overlapped ranges of effect, select the subject color with 
[ ] and adjust it again so that the range of effect of the hue and 
saturation no longer overlap.

Deleting an Adjusted Color
Be aware that you cannot recover deleted colors.

From the list, select the adjusted color you want to 
delete and then press the <Del> key on the keyboard.
The selected adjusted color is deleted.

Displaying the Adjustment Color List and its Functions

Color before adjustment

Color after adjustment

Displays overlapped range of effect of adjusted colors
Remove the checkmark to disable the adjustment
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You can select the color display mode which will be the basis for color 
adjustment from three options (HSL, Lab, or RGB) as well as checking 
values for adjusted colors.

 When “HSL” is selected for the color display mode, you can only 
change the color value for before adjustment by entering a 
number.

Color Display Mode

Switches the color display 
mode

Color value before adjustment

Color value after adjustment

 HSL is a color display mode using the three elements of hue (H), 
saturation (S), and luminosity (L).

 Lab is a color mode developed by the CIE (Commission 
Internationale d’Eclairage) where L is for lightness, a for color 
elements from green to magenta, and b for color elements from 
blue to yellow.

 RGB is a color display mode using red (R), green (G) and blue 
(B), the three primary colors (additive colors) of the visible light 
spectrum.

You can adjust the brightness and contrast for the luminosity of the 
entire image using the tone curve. To further adjust contrast and 
brightness after adjusting image characteristics with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet, use the tone curve in this 
[Specific Colors] tab sheet.

Adjust the brightness and contrast.

The brightness and contrast of the image change.
 The horizontal axis shows the input level and the vertical axis 

shows the output level.
 The maximum number of [ ] is 10.
 To delete a [ ], select the [ ] and then either press the <Del> 

key on the keyboard or double-click on the [ ].

Adjusting the Gamma Characteristic for Luminosity

Click to add a [ ] 
(adjustment point) and 
adjust by dragging

The value of the 
selected point (you can 
also enter numerical 
values)
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Saving the Adjustments as a Picture Style File
Adjustments specified in the [Tool palette] (p.11 to p.18) are saved on your 
computer as an original Picture Style file (extension “.PF2” or “.PF3”).
The adjustments are saved as a Picture Style file which is separate from 
the sample image, and the sample image used to perform the 
adjustments is not affected at all.

1 Click the [ ] button.
The [Save Picture Style file] window appears.

2 Specify the file name and save destination and then 
click the [Save] button.
 Only one-byte characters can be entered in the [File name], 

[Caption], and [Copyright] boxes. 
 If you do not want to show the settings adjusted in PSE, 

checkmark [Disable subsequent editing] and save, so that the file 
cannot be opened again in PSE.

The file is saved as a Picture Style file in the specified save 
destination.

Results of the following adjustments are not saved if saved in PF2 
file format. Be sure to save results in PF3 file format.
- Adjustments made with [Fineness] or [Threshold] for [Sharpness] 

in the [Basic] tab sheet
- Adjustments made with the tone curve in the [Basic] tab sheet
- Adjustments made with the [Six Color-Axes] tab sheet

Even if you checkmark [Disable subsequent editing] and save, you 
can use the Picture Style file the same way as the Picture Style file 
without chekmarking and saved (p.20). However, you will no longer 
be able to open the Picture Style file in PSE. For this reason, we 
recommend that you save separately beforehand the Picture Style 
file without checkmarking [Disable subsequent editing].
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Using a Picture Style File
Saved Picture Style files can be registered in the camera and applied to 
shot images. They can also be applied to RAW images using DPP.

Picture Style files saved on your computer can be registered to the 
“Camera that has a Picture Style function settings” (For information on 
whether your camera is equipped with the Picture Style function, refer to 
the camera’s Instruction Manual.) using EOS Utility and applied to shot 
images. 
Refer to “Applying Picture Style Files to the Camera” in “EOS Utility 
Instruction Manual” (PDF electronic manual) for details on operation.

Picture Style files saved on your computer can be applied to RAW 
images using DPP. 
Refer to “Using a Picture Style File” in “Digital Photo Professional 
Instruction Manual” (PDF electronic manual) for details on operation.

Picture Style files created with [Base Picture Style] set to [Fine 
Detail] cannot be registered to the cameras which do not have [Fine 
Detail] as a preset Picture Style.

Registering a Picture Style File to the Camera

Using a Picture Style File with DPP
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Preferences
You can perform color management settings such as specifying the 
work color space for the sample image displayed in the main window, or 
setting the profile for the monitor.

1 Select the [Tools] menu  [Preferences].
The [Preferences] window appears.

2 Specify the required settings and then click the [OK] 
button.

The settings are applied.

If you have changed the work color space during the adjustment 
process, the adjustment point on the color wheel may move in 
conjunction with the selected work color space.

Exiting PSE
In the main window, select the [File] menu  [Exit].
PSE exits.
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Reference

If PSE is not operating correctly, refer to the items below.

 Select an administrator-level privilege ([Computer administrator], 
[Administrator], etc.) as a user setting. You cannot install the software 
if a user setting other than an administrator-level privilege is selected. 
For detailed information on selecting an administrator-level privilege, 
refer to your computer user’s manual.

 PSE does not operate correctly on a computer if its system 
requirements are not met. Use PSE on a computer with compatible 
system requirements (p.2).

 Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.2), if other applications are running at the 
same time as PSE, you may not have sufficient RAM (memory). Exit 
any applications other than PSE.

 Sample images that are not supported by PSE (p.3) do not display.

Installation could not be completed correctly

PSE does not work

Images do not display properly

Troubleshooting
 Exit any applications before uninstalling the software.
 Log in under an administrator-level privilege when uninstalling the 

software.
 To prevent computer malfunctions, always restart your computer after 

you have uninstalled the software. Re-installing the software without 
first restarting your computer is particularly likely to result in computer 
malfunctions.

 Uninstall the software according to the OS software uninstalling 
method.

Deleting the Software (Uninstalling)

Windows 10, Windows 8.1
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About This Instruction Manual
 It is prohibited to reproduce, in whole or part, the contents of this 

Instruction Manual without permission.
 Canon may change without notice the software specifications and 

contents of this Instruction Manual.
 The software screens and displays printed in this Instruction Manual 

may differ slightly from the actual software.
 Please note that irrespective of the above-mentioned, Canon does 

not take responsibility for the outcome of the operation of the 
software.

Trademark Acknowledgments
 Microsoft and Windows are registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.
 Other names and products not mentioned above may be registered 

trademarks or trademarks of their respective companies.
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